EXHIBIT 27 PART 4

Leader Technologies Inc. v. Facebook Inc. Doc. 657 Att. 5

Dockets Justia.com


http://dockets.justia.com/docket/delaware/dedce/1:2008cv00862/41430/
http://docs.justia.com/cases/federal/district-courts/delaware/dedce/1:2008cv00862/41430/657/5.html
http://dockets.justia.com/

Chapter 6: iManage DeskSite Advance Functions

6. Click Compare to perform the comparison.

Using FullAuthority or CiteRite

FullAuthority and CiteRite are software applications provided by Lexis-Nexis
that enable you ta analyze the citations in a document. For the FullAuthority and
CiteRite menn options in iManage DeskSite to work properly, these applications
must be integrated cosrectly with iManage DeskSite.

To analyze citations in a document using FullAuthority or CiteRite: ﬂ

1. Highlight a document in the document grid.
2. Select Applications from the Document menu.

3. Select FullAuthority or CiteRite from the submenu that appears. The Full-
Authority or CiteRite dialog box appears with the highlighted decument
listed in the dialog box.

4. Inthe Output Doc Name Feld, ener a filename that will be used to store the
table of authotities or citation report that will be produced by FullAuthority
or CiteRite. '

—  Select the Dpen radic button to open the output file automatically.

—  Select the View radio button to view the output file in the iManage
Viewer

—  Select Import to add the gutput file 1o an iManage library.

5. Click Rum to ran FullAuthority or CiteRite analysis on the selected docu-
ment,
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Figure 6.2: Fuliduthority dialog box
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Configuration Options

iManage DeskSite atlows you to customize the way information is displayed. To
access the Display Oprions dialog, select Options from the Options menu, The
Configure dialog is displayed in three tabs, Select Profile Fields, Defaults, and

Configure.

Select Profile Fields Tab n
The Select Profile Ficlds tab allows you to customize which profile ficlds dis-

play in the Document Grid and the Document Profile tab in the Document
Results Frame.
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Figure 6.3; Configure dialog, Select Profile Fields tab

To customize the Bocument Grid

The Display Column Fields tist contains those fields that are already selected to
be inchuded in the Document Grid (upper right side of the iManage DeskSite
Desktop). The column ficlds appear in the Document Grid in the samc order in
which they appear in this list.

1. To add profile fields to this List, select the desired ficld(s) from the Available
Profile Fields list and click Add.

2. To remove a profile field from the Document Grid, seleci the fields in the
Display Cohimn Fields list and click Remove.
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3. Dragand drop the selected fields into the desired order.

To Customize the Document Profiles $ab of the Document Resulis Frame

The Profile Fields list contains those ficlds that appear in the Document Profiles

tab of the Document Results frame in the lower-right side of iManage DeskSite

Desktop. Thesc ficlds appear in the same order in which they appear in the list.

1. To add profile fields to the Profile Fields list, select the desired ficld(s) from
the Available Profile Fields list and click Add.

2. To remove profile fields from the profilte list, select the fields in the Display
Column Fields list and click Remove.

3. Drag and drop the selected fields into the desired order.

Defaults Tab

A mumber of different system settings are completed in the Default tab of the
Display Gptions dialog.
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Figure 64: Configure dialog, Defaulls tab

Options of the Defaults tab:

»  Inthe Maximum Niumber of Decuments in Search Window field, enter
the maxinum mumber of documenis that should appear in the Docoment
Grid as the result of a search. The defantt value is 500,

« Inthe Document Version box, select either All Versions or Latest Version

Only.

Note: If you select Latest Version Only, you can stifl fecate all the versions of a
document in the library by highlighting the document in the grid, then clicking

the Document Versions tab.,
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+  Inthe Change Portable Options box, you can change the drive designation
of your Portable directory. The Portable Path is hard-coded to NRPORTBL.

»  Inthe Change Echo Options box, you can change the drive designation of
your echo directory and the size, in megabytes, of the Echo Directory. The
Echo path is hard-coded 1o NRTECH. You can also change the size of your
Echo Directory by clicking the up or down arrows next to the Echo Size
(MB) field.

+ Inthe WorkSite box, you can emter the URL for accessing imanage Work-
Site in the Base Path fiekl. iManage DeskSite uses this information when
you enter the commands Send Document URL Link or Send Folder LIRL
Link from Send on the Pocument menn.
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Configure Tab
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Figure 6.5: Advanced Options dialog, Defaults tab

Timeout Option

Use the Timeount option to detexmine how long the iManage DeskSite client

waits before timing out. The default value is 30. You may need to increase this

value when connection {imes ate slow or when downloading large files, for

example, over a WAN conniection,
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Document Options

*  When Use Forms and Captions from preferred database is checked, the
iMapage DeskSite client downloads the Forms and Captions stored on the
user’s Preferred Database as you need them and applies these forms and cap-
tions fo other databases. When this option is not checked, Forms and Cap-
tions are downloaded from each individual database as yon need them.

»  When Check for Checked Qut Decuments on startup/exit is checked, the
iManage DeskSite client presents an alert message immediately afler login
whenever it detects altered checked out portable documers on your hard
drive.

»  When Add implicit wildcard characters (o description searches is
checked, IManage automatically inscris an asterisk at the beginning and end
of \he search string in the description field when performing a profile search

+  When Delete local files after import is checked, iManage removes docu-
ments from vour local drive after vou import them to iManage DeskSite.

+  When Filter COMPARE and OCR classes out is checked. iManage
DeskSite excludes all documents with the COMPARE and OCR (optical
character recognition) docament classes. If you want to inclode documents
creafed with decument comparison or OCR software, make sure this box is
not checked.

»  When Check for medificd echo documents on startup/exit is checked, the
iManage DeskSite client presents an alert message immediately after login
whenever it detects aléered echo documents on your hard drive.

»  When Check for orphaned documents on startup/exit is checked, ihe
iManage DeskSite client presents an alert message immediately after login
whenever it detects orphaned documents on your hard drive. See “Orphan.
Docnments” on page 195 for more information about orphaned documents.

Other Options

»  When Verify before exiting iManage DeskSite is checked, yon get a mes-
sage asking if you arc surc you want to close iManage when you click the
exit button or select Exit from the File memn.

+  When Check for Microsoft Word before exiting iManage DeskSite is
checked, iMamage DeskSiie determines if (he Mictosoll Word application is
open, If 50, you receive a wamning message asking if you want to close iMan-
age DeskSite even though Werd is still ranning.

+  When Choose connection mode when sixrting is checked, you have the
option of commecting to the server, working in Portable mode, or logging in
manuaily.
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Figure 6.6: Server Connection dialog

- Hyouchoose Connect, iManage DeskSite opens and connects to the
servers that are registered and selected for auto login,

—  Hyou choose Portable, iManage Portable opens.

~  Ifyou choose Mannal Login, ithe Register Servers dialog opens so you
can log into the servers you choose. Sec “Connecting to WorkSite Mid-
die Tier Servers” oo pags 44,

«  When Always sort worklist by my access time is checked, the work tist on
the documemnt grid sorts in the order in which the current user accessed the
documents. This order may differ from the actual edit time of some docu-
ments since the edit time of a document changes if another user accesses the :
file. ‘

«  When Show Worklist separately for each database is checked, the tree
frame shows both a consolidated worklist that includes ail databases and an
individual worklist for each database that shows the documents that you
worked on most recently from just that database.

»  When Show overflow message if search returns have more entries is
checked, you receive an indicator in the status bar showing that your search
request received more matches than in (he search results list.

Fignre 6,7; Overflow indicator

Purge temp documents if older than __ Days

When yon perform Print, View and Quick View operations in iManage DesksSite,
the system creates temporary files on your computer. This setting lets yon defer-
mine how long to retain these files. When you close iMariage DeskSite, these
files are permanently deleted after the mmbes of days you specify here.
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Default Command

Select from ke list of commands in the Defawlt Command drop-down menn to
decide what a double-click should signify in the Document Grid. Sez the table
below for details. Click OK when you have finished sctting defaults.

Tabie 6.1: Options for double-cticking in the grid

i you select... | When you double-tlick on & document in the
grid...

Open iManage DeskSite opens the docoment in its asseciated
application.

Edit Profile You can view or edit profile information for the document.

Print iManage DeskSite prints the document.

Quickview The document appears in the Quickview frame.

View iManage DeskSite opens the document in the View appli-
catiorn

Versions The documemt version tab displays a list of all the versions
of the document.

History Document activity history for the docnment is displayed

Related The related document tab displays a list of all the doca-

Documents ment related to the selected document.

Checkout The Checkout dialog box appéars with the document listed
as the document to be checked out.

Checkin The Checkin dialog box appears with the document listed
as the document to be checked in.

| Checkedout i iMam_gé DeskSite 707pens ihe Checkedout Info nessage '

Info box.

Export iManage DeskSite opens the Zxport dialog box.

Unlock iManage DeskSite unlocks the document.

Remove from iManage DeskSite removes the document from the cumrent

Folder folder. The document is still in the library.

Purge iManage DeskSiic deletes the document from the library,
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Overview

iManage View lets you vicw documents without the need to Jaunch their native
applications. You can view multiple documents and print all or portions of the
docoments being viewed.

To view documents from the iManage DeskSite program, select one or mote doc-
uments you want to view in the document grid, then select View from the Docu-
ment memi. A submenu appears; select View again from the snbmenu. If
iManage View is not mnning, iManage DeskSite launches iManage View, then
displays the documenis in read-only format. You can also display documents in
iManage View by highlighting muliple documents, then clicking on the View
button in the toolbar.

To view documents from the iAManage Infegrated Deskiop, select documents in
the decuments list and nght-mouse-click. Then choose View from the pop-up
merm. The iManage View program: will launch with the documents displayed ina
view window.

You can also faunch the iManage View application manually.
iManage View allows you to:

< View documents in read-only format even when they are checked out or in
use.

«  Search the full text of documents curmcntly displayed in the viewer.
+  Copy portions of documents for pasting inlo other applications
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Print documents

File types sapported by iManage View include all major word-processing,
spreadsheet, and graphics file formais.

Note: When you view documents using iManage View, those documents are not
locked or checked out of the database. Instead, the iManage View program makes
a temporary copy of the document, which is displayed in read-only format.

Document Types Supported

Word Processing Formats

Word for Windows 1.0, 2.0, 6.0/7.0 and 2000

WordPerfect for Windows or DOS 5.0, 5.1/5.2, 6.0 and 7.0

AmiPro 3.0

Word Pro

Windows Write

Word for DOS 5.x and 6.0
Proféssional Write 2.0

Display Write

MultiMate

OfficeWriter

Wang PC

FrameMaker Interchange Format (MIF) (text only)
StarOffice Writer 5.2 (text only)
ANSI Text

Spreadsheet Formais

Excel 3.0, 4.0, 5,0 and 7.0
Lotus 1-2-3 for Windows or DOS 3.x and 4.x
CuattroPro for Windows

The major word processing, spreadsheet, and graphic formats supported by
iManage View are listed below:
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Graphic Formats
Windows Bilmap
Windows Metafile
WordPerfect Graphic 1.0, 2.0
Ami Draw
Tagged Image File Format TIFY
Micrografx DRW
CompuServe GIF
Paintbrosh PCX

Miscellaneous Formats
Adobe Acrobat PDF (te:it only)
Website META Language (WML)

Presentation Formats 7
Migrosoft PowerPoint

iManage View Window

If yon taunch iManage View manually, the iManage View window initially con-
taing no documents, If launched antomatically—such as when you select the
View option in iManage DeskSite—this window contains read-only copies of the
documents that you selected. Below is an example of the iManage View window
with three local documents displayed in tile format,
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Tile and Cascade Formats

You ¢can display documents in cascade or tiled format. Figyre 7,1 shows an exam-
ple of the filed format. Following is an cxample of the same iManage View win-

dow with ihe three documents displayed in cascade format. You can also display

other documents in the window as minimized icons.
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Figure 7.2: iManage View with documents displayed in cascade format

Viewing Local Files

You can use the iManage View program 10 view documents on an iManage data-
base andfor decuments that are stored locally on your hard drive or another net-
work drive.

To view local documents:

1. Launch the iMamnage View program.

2. Select Local Open from the File menw, The Select Local File to View dia-
log box opens.
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Figure 7.3; Select Local File to View dialog box

3. Use standard Windows tecliniques to locate and select a local fils to view in
the iManage View program, then click Open 1o display the file in the view

Searching the Full Text of Documents

|

Seaich Sting: [Knowledge Euniérsncei ~|
- Options — e e ;
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™ Matsch Case " From Cuesor |
¥ Find Backward & Ertina Soope ]
Bl [k ] caee |

Figure 7.4: You can use the Find dialog box to search the full text of any docu-
menis displayed in iManage View
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Note: The Find Text dialog box operates only on the active document displayed
iniManage View. That document must be a word-processing document or
spreadsheet. Textual searches canmoi be performed on other document types.

. Select Find from the Search memu.

2. Enter the text for which you want to search in the Search String ficld.

3. Ifyou click the down arrow :j you can select from a list of search strings
that yon emiered previously.

4, Click OK to start searching.

Search Options

«  The Match Case option specifies whether the search should be case-sensi-
tive, If you do not check Match Case, all instances of your search string will

be found regardless of whether they appear in upper or lower case.
«  The Origin options specify where the search should start, I From Cursoris |4
selected, the search will begin at the current position of the cursor in the
active document. If Entire Scope is selected, the search will begin at the
start of the document and proceed forward, or at the end of the document and

proceed baclovard, depending on which direction is selected.

+  The Find Backwards option specifics the direction the search shonld pro-
ceed.

Printing Documents

You canprint all or portions of documents that are displayed in iManage View by

clicking on the Print icon (8| or by selecting Print from the File meeu. You may
also select Copy from the pop-up menu on a right-mouse-click. When you select
Print, a standard Print dialog box appears. The Print option operates on only the
currently active document in the iManage View window.

Setting Print Options

You can set printer opiions from the iManage View window by selecting Printer
Setup from the File puildown menn. A standard Print Setup dialog box appears.
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Copying Documents

You can copy all or portions of documents for pasting into other applications by
highlighting the portion of the document that yon want to copy. then clicking the

Copy icon or selecting Copy from the Edit memu. You may also sclect Copy
from the pop-up menu on a right-mouse-click.

Setting Display Options

You can display documenis in iManage View ina number of different formats.
Different documents can be displayed in different formats at the same time.

Word-Processing Documents

You can display word-processing documents in Drafi, Nermal, or Preview
mode:

«  Draft mode displays the document using the defanlt font without the origi-

nat formatting,. Text wraps as necessary to display all text in the view win-
dow.

«  Normal mode dispiays the document using the specified fonis in ihe docu-
menss and using the specified formatiing. Text wraps inside the view win-
dow to display all text in the document.

+  Preview mode displays the document using the specificd fonts and specified
formatting. Texi does nol wrap in the view window: Preview mode shows
how the document would look when printed,

Bitmap Files

You can adjust the size of bitmap files that are displayed in the iManage View
program and/or Totate these images in the display by increments of 90°. To
change the size or rotation of a bitmap image, select the window in which the
image is displayed. then sclect Bitmap from the Options menu. A submenu of
display options appeurs, Select the size and/or rotation desired.

Vector Graphics

You can adjust the size of vector graphics files that are displayed in the iManage
View program by sclecting Vector ftom the Options menu. A submenu of dis-
play aptians will be displayed. Select the option desired.
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Setting Default Display Options

You can select a default font that will be used to display ANSI text and select a
file format to use to view files of unknown type. To set these options, select
Options, Document, then Font. The Display Options dialog box will be dis-
played. The Display Options dialog box lets you specify iMamiage View’s defanlt
fonis and file formats.
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Figure 7.5: Display Options dialog box

«  To change the default font of ANSI files, click the Change button. A stan-
dard Windows Fonts dialog box appeatrs, allowing you to specify the font.

«  To set the default display mode for documents of unknown file type. sclect
the corresponding display option.

» To display additional options, click More. The More Display Options dialog
box appears.
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More Display Options

You can also set display options that specify how to display databasc tables and
spreadshect information. If you want to show gridlines for either of these dis-
plays, check the Show gridlines options.

The More Display Options dialog box is displayed by clicking on the More bat-
ton in the Display Options dialog box.

Note: The options included for specifying display options for archived docu-
menls arc nol implemented.

More Disml:_a Uphions
~ Sp¥eadshest

W Shaw gidines

~ Database —

€ SortFles by name

¢ Sort files by size

™ Sort Alks by date & time
-Sort Drder ——————
" Ascending
1" Desoending

Figure 7.6; More Display Options dialog box
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A portable mode of operation allows you take the iManage DeskSite document
managemen system on the road with you and helps yon synchronize your work
with the network when you get back to the office. The process works Like this:

A user checks out the desired iManage DeskSite documents, individually or
ef masse.

Once disconnected from the network, you can access poriable documents
through the iManage Portable application or through the standard commands
(open, save, elc.) of an integraled application.

When the user re-attaches to an iManage. DeskSite database, you can awmio-
matically check in the checked out documents and synchronize themn with
iManage DeskSiie.

From Portable mode while disconnected from the nctwork you can perform
the following standard iManage functions:

-

-

Import docuinents and assign a new document profile
View and Quickview documents
Save edited documents as new documcnts

Save edited documents as the same docutnent, thereby replacing the network
version when synchronized with iManage DeskSite

Edit and View document profiles
Send documents as attachments to emails
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What you ¢annot do in Portable Mode:

+«  Save document as a new version of the same document
»  Edit document security

Note: Eche docunents are also accessed through portable mode. See Chapter 9.
Using Echo Documents.
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Setup Procedures

Portable-mode operation does not require extraordinary amounts of memory or
resources on the portable PC and does not require a separate stand-alone SQL
database on the portable PC.

To access portable documents effectively, you need to set up your PC in the
following manner;
< The PC must be registered Tor portable-mode operation.

+  The PC should be able to run from a local copy of the Windows operating
system.

-  Local stand-alone versions of the application programs associated with the
portable documents should be available on the PC.

Application Setup in iManage Portable

The local application table contains information that is used by iManage Portable

to launch applications and to associate particular docurnent types with appropri-
ate applications. It is recommended that you do NOT edit the local copy of the ﬂ

application table UNLESS yon understand the way applications are integrated
with iManage. Information on how the application table is created and main-
tained and how iManage is integrated with other applications is provided in the
iManage DeskSite Adminisirative Reference AManual.

Reasons why you might need to change the Tocal copy of the application table
inclnde:

»  The path to an application changes
«  You want fo associate a document type with a different application

»  You want to integrate an application that is not listed in the application table
on the database

To Add or Edit an entry to the local application table:

§. Click the App Setup icon [¥¥] or select Local Applications from the
Options menu.

2. Click the Add or Edit button in the Appfication Setup Information dialog.
3. Complete the fields in the 4pp Setup Entry dialog. Click OK when finished.
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Note: iManage Portable’s on-line help contains a detailed explanation of each
field appearing in the App Setup Entry dialog,

Checking Out Portable Documents from iManage
DeskSite

iManage DeskSite provides you with the ability to check out multiple documents
in a single operation for portable-made access, The checked-out documents are
marked as in use in iManage DeskSile.

The checkoul process copics the documents to the portable~document location on
the local PC. This location is defined during portable-mode registration.

The profile information of the checked-out documents is aiso copied to the local
portable-document location, iManage Portable uses the local profile information
to find and access portable documents. You can change the prefile information in

portable mode.
n To checkout a docament in portable mede:
1. Selecta document by clicking on it in the iManage Desktop window’s Dacu-

ment List. The document row becomes highlighted,
2. Click the Checkout toclbar buiton, The Chechout dialog box appears.
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Checkout
e CHocUnSnt IROImELIOn -y }
' Database:  Finance
Yooty 1

— Details : _

DueDale: | 821701 ¥

Copiwnents;

[ ] cawel | Heo

Figure 8.1: Checkout dialog box

3. Place a checkinark in the Portable Checkout ficld. The Destination Path
ficld becomes deactivated because all poriable documents are stored in the

same directory.

4. Note your reason for checking out the document in the Comments field,
specify the duc date, and click OK. The iManage Desktop window reap-

pears.

Working with Portable Documents from within Integ rated
Applications

CONFIDENTIAL

You can open documents that are checked out in portable mode from within inte-

grated applications.
Steps:

I. Lamich iManage Portable if it is not already running,
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2. Launch the inlegrated application

3. Select Open from the File menu in the integrated application. The fnfe-
grated Portable Deskiop dialog box appears.

L. 5 Comorale
{3 Comespondence
: dhasefl

* gl Dev

i @l Eugens

" 3 Finance

{3 HA

j--f3l HRD

. 3 Docs

L5l imanl

» -Pl imanbb

i (@ iman2 1141 - s s | 3
L Monogs | Detobaie:  [Fiiarice EufertView: [Crackedow ] Showpiedts |
; (@ Legal I I_ 7] ™ aen |

i B Marketing Blamher. Yorsers "i

Fiker Condifioris:

;;?:EEEI';A “ﬂ'ﬂ# I i Mnl:ﬂ‘ad Un' I.&n'l_r,- ] Cancel 1

1
1 . BA21 /01 93050
n. Maketng... 412 1 WUKD.. DOC 642100 93114
. Proposaks 1t 1 WLKD.. DOC 6721/ 9:30:44

dé ..... b= p.ﬁ:.....r ‘fynmwmﬁﬁl"'“*ﬂd

Figure 8.2: Infegrated Portable Desltop dialog box

Working with Portable Documents from within iManage
Portable

You may access documents directly from the iMianage Portable application.

Read-only documents are indicated in the Portable directory by a locked imn% .
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Figure 8.3: iManage Portable Application Desktop window

To Open Portable Documents

1. Launch iManage Portable and select Chackedout Documents from the
drop down list. The Checkedout Documents list appears in the panel.

Select the desired document and click the Open icon [£5] or just double-click
on the desired document. The document opens in the local application that is
associated with the document’s type.

Note: The Portahle program looks for docniments that were checked out by the
same user whose ID was used to log into Windows. If you checked out docu-
ments for poriable use using a user ID other than the one you used to Jog inlo
Windows, the Portable program will not be able to find those documents, If that
happens, log cut of Windows and log back in using the user ID that you used 10
log into the WorkSitc Middlc Ticr Scrver when you checked out those portable
documents.

To View Portable Documents

CONFIDENTIAL

There are two options to view poriable documents.

AUTGD20179



CONFIDENTIAL

iManage DeskSite User Reference Manual

To view a portable document using the iMenage View program:

iManage View is a sophisticated viewer program allowing you to view multipie
documents at the same time and in different formats. To view a docuiment this

way, highlight the desired document(s) and click the View icon |5#4| or select
View from cither the Document menu or the right-click pop-up memm on the
selected document.

To view a portable document using Quickyiew:

Quickview is an easy way 1o view a document wiihout leaving the Portable appli-
cation. To view a document this way, highlight the desired document and click

the Quickview icon [ or sclect Quickview from either the Document mem
ot the right-click pop-up memn on the selected document,

Editithiewing Portable Document Profiles

Portable document profile information can be accessed and edited by highlight-

ing a document in the document list and clicking the Edit Profile icon || 4] or by
selecting Edit Profile from either the Document menu or the right-click pop
ap menu of the highlighted document. Profile information can then be viewed
and updated. Updated profile information is verified when the portable ducu-
ments are checked back into iManage DeskSite,

Printing Portable Documents

You can print documents directly from iManage Portable by clicking on the Print

icon || or by selecting Print from either the Document memu or the right-
click pop-up Teenu on the highlighted document. This will antomatically launch
the document in ils associated application and perform a print command.

Note: This portable print command does not launch a Print Options dialog box
before printing. See the next section aboul Print and Page setup options.

Print and Page Setup Options

Select Printer Setup from the File meno to launch the Printer Setup dialog,
This dialog provides choices of printers, page types and Portzaitl.andscape ori-
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entation formats.
E-mailing Portable Documents

From the iManage Portable application you can create 2 new e-mail message
with selected documents as atlachments.

3. Select the document or documents von wish to attach and click ihe Send icon

or select Send from either the Document menu or the right-click pop-
up menu of the highlighted document. The Mail Documents window 0pens.

I M all Documents

N« | Ver | Desgigon______

NE RN u

Figure 8.4: Mail Documents window
4. Tf this is the documeit you wani to send, click Mail. A new e-mail launches

autosmatically from your e-mail application with the sclected documenis as
attachmenis.

5. You can remove any document from the fist by highlighting thc document
and clicking Remave,

Import Documents to iManage Portable

If you have created a brand new document while away from the network you can
integrate it with iManage DeskSite when you return to connectivity. Do this with
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the Import feature.

Steps to Import:
1. Launch iManage Portable.

2. Click the Import icon | 4] or sciect Import from the File mem.

Fired Frle To Impoit ﬂﬁ

Loskir: [ Wanage -l & o [ e
3 Ve 8] Crits.do %] Debmp.dl
5] Code.dI 8] Dehex di
£ Dhbirdmin.exe ] Demet di
[8]DbadminGID 18] Dessdl
gﬂbadnin.hb 8] Detree.dl
£) DBAdminlog 8] Devp.dl _
Flagame | - Dperi |

Fiesattipe. JAIFms = s - |

Figure 8,5: Find File To Import dialog box

3, Use the Find File To Import dialog to mavigate to the document you wani o
import. When highlighted, click Open.

4. ‘The New Document Profile dialog lavnches. Complete the document’s pro-
file and click OK when complete.

The document then appears in the document list of iManage Portable. I is ready
to be checked in with all the other documents when you re-connect to the net-

work. :

Check-in Portable Documenfs

When you have been working in portable miode and you attach to an iManage
DeskSite database, you can check in the checked ont documents and synchronize
them with iManage DeskSite. The check-in process verifies the profiles of the
portable documents against the profile-entry tables. If errors are detected, you are
prompted io enter comect information.
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To check-in a portable document:

1. Launch iManage DeslcSite and click Checkin on the toolbar. The Checkin
Documents dialog box appeats,

2 Select the documents to be checked in using standard Windows techniques.
3. Ctick the Checkin button. The Checkin Options window appears.

4, Select either the Replace Original or New Version option. To apply the
selected option to the entire group of documents that you're checking in,.
select Apply to All.

5 Click OK to check in the documents and return 1o the Checkir Documents
dialog box.
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Overview

All computer networks fail at some point. iManage has created a safeguand for
such an event. It’s called document echoing.

Every time you close an iManage document, iManage DeskSite saves a duplicate

copy o your hard disk, This is done to ensure thal you can still access and per-
form functions to your important and recently used files, even when the network

Fails.

If you make revisions to these documents offline, iManage DeskSite pravides a
synchronize function to integrate revised echo documénts back into the network.
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Setup

Enabling Document Echoing

iManage DeskSite cchoes documents on your PC only if Document Echoing is
enabled.

Your iManage DeskSite administrator can disable document echoing globally or
for any given class of documents. If your PC is registered for portable mode but
iManage DeskSite is not echoing documents to your hard drive, contact your sys-
tem administrajor for more information.

If you are enabling document echoing as a safeguard against network failure, you
should also ensure that your PC is able ta run a local copy of the Windows oper-
ating system and local, stand-alone versions of the application programs associ-
ated with your echoed documents. In the casc of a network failurc, networked
copies of Windows and of essential application programs are not available.

Even in the absence of the application programs associated with your echoed
documents, if you have a local capy of the Windows operating system on your
PC, you can view your echoed documents using iManage View.

n Setting the Default Drive for Echo Do¢uments

You can select the disk drive where iManage DeskSite saves echo documents,
Normally, the echo documents are stored on a disk drive on the uset s local PC.
While the disk drive forthe echo direciory can be changed, the name of the direc-

tory ig always nrtecho.
1. Choose Options from the Options menmu to open the iManage Desktop
window’s Configure dialog.
186 AUT0020186
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Conhgure

Select Profle Fields  Defatits ] Configure |
Search

_* Change seanch resuk opticne.
3% M aximum namber of documents in Search windovr:

oy

rDmenWmion T
6 LalestVaisionOnly € AllVersionis |

i

BN

Portable
Change portabls options.

Bl Portatsle Drive: iU "']

Potable Path:  NBPORTBL

Echo
o, Ehange echo ogtioris,
Echa Drive: cC -
Echo Path: NRTECHO
Echo Size(MB]: |25 <
WokSite

Baszp Path:
i@ thtp: Hhworksite_imanage. com

DK Cancel Help

Figure 9.1: Display Options dialog where Echo defaulis are set.

2. Specify the disk drive where iManage should store your echocd docurments
and the maximum size of the echo directory. If the total size of the echo
directory exceeds the specified limit, iManage DeskSite prompis you to
purge the echo directory. For instructions on how io purge echoed files from
the echo directory, see “Purging Echo Documents” gn page 196. You can
change the size of 1he echo directory, if you need 1o, by clicking the up or
down arrows in the Echo Size (MB) field,
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Using Echo Documents

You can access echo documents either through the iManage Portable application
or through an integrated application such as MS-Word, WordPerfect, ctc.

Note: If you attempt to open a document that is currently in your Echa directory
because you worked on it previously and made changes to it that are not reflected
in the copy on the file server, iManage DeskSite will not Iet you open the docu-
ment. Since iManage DeskSite copies a docoment to your Eche directory when
you open it, this featare prevents you from overwriting changes that you made to
the document.

Access Echo Documents from an Integrated Application

Steps to open documents that are checked out in portable mode from within inte-
grated applications;

1. Launch iManage Portable if it is not already running.
2. Launch the integrated application.
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Figure 9.2: Integsated Portable Desktop

Access Echo Documents from the iManage Portable

Application

Launching iManage Portable allows you Lo perform a variety of funcdons wilh

echo documents. ‘The main desktop screen looks like this:
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Figure 9.3: iManage Portable Desktop Window

Functions within iManage Portable

Because both Echo Documenis and Portable documents are accessed through
same Portable application the document fumctions are identical. Chapter 3 con-
tains greater detail of the following document commands:

Open Echo Docaments
Double-click on the desired document in the Echo Document Eist or highlight

the document and click the Open icon . You then get a message that the doc-
ument may have been changed by another usor. If this is the case, you can check
in the document 1o iManage DeskSite only as a new document.

Your system administrator may have configured your machine to display echo
documents for all users on your machine,
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s

f!

You aie opening art echa capy of the décument "1018130_1". This
docunent may rot reflect the latest changes made lo the document in
iManage, After you adi it, vou may be able lo copy it bsck to iManage

onlp a5 & new version. Do you want to continue?

“'es J No

Figure 9.3; Eche document warning message

Yiew Eche Documents:

Highlight the document(s) and click the View icon . This will launch iMan-
age View - a sophisticated viewer application. See Chaptet 7 for more informa-

tion

Quickview Echo Decuments

Highlight the desired document and click the Quickview icon[53}) The document
will be displayed in the bottom right frame of the Portable Deskiop Window.

Printing Echo Documents

Highlight the desired doenment(s) and click the Print icon |, The document’s

associated application will laanch and the document will be printed. Please note
(hat this portable print command will not launch a Print Options dialog box
before printing. See the next section about Print and Page sehip options.

Printing a List of Echo Documents

To print a list of the documents currently displayed in the Decument List of the
Poriable Desktop select Print Preview from the File menu. This will launch the
tist in the Print Preview dialog where you can execute a priat command.

Sending Echo Documents

Highlight the desired document(s) and click the Send icon [R] A new e-mail
will launch antomatically with the selected documents as attachments.

CONFIDENTIAL
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Saving Echo Documents

After opening an echo docuinent, yon can save changes or revisions to it with the
Save comnzand under the File menu in the application associated with that docu-
ment. Documenis saved using the save command will be recognized in iManage
DeskSite as echo docoments. If you use the Save As comnmand 1o create a new
document from a revised echo decument, however, the document will be identi-
fied as a new portable document in iManage DeskSite.

Deleting Echo Pocuments

Highlight tho desired document(s) and click the Delete icon [, You can also
delete Echo docnments from the Checkin/Synchronize dialog box in iManage
DeskSite.

Editing and Saving Echo Documents

Afier opening an echo docnment, you can save changes or revisions to it with the
Save command under the File menn in the application associated with that doc-
ument. Documents saved using the save command are recognized in iManage
DeskSite as echo documents. If yon nse the S8ave As cominand 1o create a ew
document from a revised echo document, however. the document is identified as
a new portable document in iManage DeskSite.

n Synchronizing Echo Documents into the Network

If you edit and save an echo document while offline, you will eventually want to
copy the document back to the network after network connections are restored.
iManage DeskSite provides an easy way to copy echo documents that have been
revised and saved locally back to the network. This process of copying altered
echo documents back to the network is referred to as synchronization.

When vou start iManage DeskSite you will get a wamning if you have ccho docu-
ments with changes that are not reflected in the copy on the file server. This fea-
ture Iiclps prevent you from overwriting changes that you made to the document.

Requirements for synchronization of a document

«  Only the last user who edited a docoment throngh iManage DeskSite may
synchronize an echo document. Other users who atternpt to do so receive a
warning message and are instructed to contact the particular user who last
edited that document.
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«  Your echo copy of a decument must be newer than the copy on the network.
iManage DeskSite does not allow you to synchronize an echo document
back to the network if the network copy of the document is newer than your
echo copy.

= You must have write acoess to the network copy of the document. You can-
not synchronize a docurnent if you have read-only access to the document.

You have the option of copying a document back as the original document,
importing it as a new version of the original docwment, or importing it as a new
document. If you are unable to use iManage DeskSite’s syrchronization process
to copy your updated echo document (o the network, you can instead import the
echo document as a new document or a new version of the same document.

To synchronize an echo document:

1. IuiManage DeskSite open the Checkin/Synchronize Documents dialog by
selecting Checkin/Synchroaize from the Portable menu.

CheckindS pachronize [ ocuments

Cheskedoat Dacurenie Echo Dosuments |

Sassion ama | PARIS B
Finance  &md70820011310.. 1 i
A Finance Project Plan 414 1 WORDY{. - __ Y
B Finance Aevised Documents 413 1 WORD: i
[ Finsnee  Marketing Options 412 1 WORD! | puge I
A ) | A
eme 5 T Showobechomedied

Yigure 9.4: Smchronize/Purge Fche Documents dialog box

2. Profile information for echoed documents appears in the display table, Use
the horizontal scroll bar to display more profile ficlds.
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«  Use the vertical scroll bar or Page Up and Page Dowm butions o dis-

play all the ¢cho docnments.

+  Use the Find button to search for echoed document profiles if the list is
large.

»  Check Show only echo modiflied (o display only il echo documenis
that have been changed,

3, Use standard Windows techniques in addition fo the Select All and Deselect
butions to select documents for synchronization back inte the iManage
DeskSite database.

3. Click Synch to begin the synchronization process. The Confirm Synchronize
dialog box opens.

~ [ocument Information :
=" Muimber:

fu—

1,078,906
Varsior:, 1
Description:  #anage Travel Profile

r- Echo Document-— —-

T . Databa:ae Documm--....__.-,..._ T
Last edit date; 1141572000 # Llasteditdste: 11/15/2000
Last acht time;  14:49:00 Last edit time;  13:22:44
File size: 25,50 KB File size; 4650 KB
Last user; BOWEN Lagt user BOWEN
- Dptions

£ NewVersion {~ New Dociment

# Replace Original

DK

Skip l

Help.

Cancel

Figare 9.5: Confirm Synchronize dialog box

5. Verify the comparison between the Echo document and the Database docu-
ment. Choose whether you want to replace the original document. create a
new version of the document, or create an entirely new document. Not all of
ihesc options are available in cvery circumstance.

«  Ifthe document is checked out in the iManage library, you can retorn
the Echo document to the library only as a new document.
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» [ ihe document is nof checked out in the iManage library and you were
the last user of the document, you can return the Echo document to the
library as a new version, a new document. or replace the original docu-
ment.

+ I the document is not checked out in the iManage library and you were
not the last user of the document, you can rehurn the Echo document to
the library only as a new version of the document or as a new document.

6. Click OK to synchronize the document, Cancel to cancel the synchronize
operation for all documents you have highlighted, or Skip to cancel the syn-
chronize operation for the specified document only.

Icons in the Checkin/Synchronize Documents dialog box

Tcons in the Checkin/Synchronize Documents dizlog indicale the condition of the
docwments displayed in the windows. The list explains what the icons mean:

= — This icon appears in the document display arca of Checkedout Docu-
ments tab. The document that it is associated with is a checkedout docu-
ment.

Ei — This icon appears in the document display area of both the Checked-

out Documents and Echo documents tab. In the Checkedout Documents
tab, this icon indicates that an “orphan”™ document exisis in the NrPortb]
directory. In the Echo Documents tab, this icon is used 10 indicate
unmodified echo documents that exist in the NriEcho directory.

B — This icon appears in the document display arca of Eche Docuntents
tab. This icon identifies echo documents that have been modified and
need to be synchronized.

Orphan Documents

A user may bave documents in his or her Portable or Echo directory which are
nol checked-out by that user (Orphan documents). When the user starts working
in Portable mode, iManage DeskSite shows that the document is checked-out.
The user can modify the document in Portable mode. However, when the user
starts iMamage DeskSite, he or she needs to know the local copy of the document
has modifications thai are not in the iManage file server copy.

iManage DeskSite identifies documents in the user's NRPortbl or NRTEcho
directory and determines if they are checked ont by the user. If there are docn-
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ments in the NRPoribl or NRTEcho directory that are NOT checked out by the
user, iManage DeskSite distinguishes those documents from documents checked
out by the uses or created in Portable mode that need to be checked in.

You can then import the orphaned documents into iManage DeskSite as new doc-
UMmeENis.

Purging Echo Documents

1. IniManage DeskSite, open the Checkin/Synchronize dialog by selecting
Checkin/Synchronize from the Portable menu,

2. Click Purge. The Set Purge Criteria dialog box appeats:

Set Puige Coteria

] ' !
| Delets dopumenis ¥ aider ih |m 5 |
Ei » ) days Jl

Ok | Ceed | e

Figure 9.6; Set Purge Criteria dialog box

3. To delete all documents older a certain rumber of days, enter the maximum
age in days of echo documents that you want to keep and click the OK but-
ton. All documents older than the specified number of days are deleted.

Note: The number of days set in the Ser Purge Criteria dialog box is only for
this manual purge of the directory. Eclio documents continue to accunmlate
unless you purge the directory in this manner again. For instructions on how to
purge the echo directory antomatically, sce the ilManage DeskSite User Reference
Meanuel

Purging Echo Documents Automatically

You can set up your computer to automatically delete echo documents based on
age at startup of iManage Portable. To implement (his feature:
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1. Create 3 shortcut to Portbl32exe
2. Right-click on the shortcut and select Properties.
3, Inlhe Properties dialog thal appears, click the Shortcul tab.

Shorkcut to Portbl32.exe Properties

General  Shoout | Securiy |

Taigel ype:  Application
Tarpet locatior: iManage
Taiget: ] 'C:\Piogram Files\id anagetPoithi32 exe' D20

WV Bunincepatate memo pace | Pum as different user

Stail inc f‘n:;wmgmm Fites\iManame"

Shorteut key: iNme

Run: {Nomal window 7]

Comment |

Find T argel... | Ehanmlcun...!

T I

Figure 9.7: Shorrcut Properties dialog box

4. Inthe Target field, enter the path to the portable exceutable file followed by -
D then the maximmn age of echo documents in days.

5. Example: If iManage is installed in the default insialtation path, you might
enter the following in the Target field:

"C:\Program Fles\iManage\Portbl32 exe” -0 20

Where 20 represents the maximum age of an echo document in days. Docu-
ments older than this specified number of days will be deleted.
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6.  When you double click on this shortcut 1o run the Portable application, any
echio documents older than the specified maximum age are deleted.

Silent Mode

You can also use this command bine feature in silent mode. Silent mode means
that when you doable click on the shoricut. the Portable application only runs
long enough to delete any echo documents older than the specified maximum
age. then exil. To implement this featnre in silent mode, substifute -DS for -D,

Example: "C:\Program FilesiManagelPorth!32.exe” -DS 20

This command line opens iManage Portable, purges echo documents older than
20 days from the echo directory, then exits from iManage Portable.

Shorkcul ta Portbi3Z2.exe Properties

Genetsl Shoitcut 1 S;ecur'ﬁy]

.@E Shorteut to Porbl32 axs

Target pe:  Application
Target location: Manage
Target r’C:hPrograrn Files\iManage\Portbi32 exe” D520

W #urin separste memey space. | Run as diferent user

Qtart in: ]"C:’\Prugum Fikeshidanaga'

Shotcut key [Hone

Rurr : lNormal window _‘:’j

Comment I

Find Target... ] Change gcm._l

oK Cancel | Apply - -

Figure 9.8: Shortcut Properties silent mode dialog box
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Purging Documents for All Users

urrent nser, ‘To do this. substitute -PS for -D or -DS.

Example: "C:\Program FilesiMenage\Porthi32.exe” -PS20

You can nse this command line to purge echo documents for all users, not just the
c

This command line opens iManage Partable, porges echo documents older than

20 days from the echo directory, 1then exits from iManage Portable.

storkeut o Portbl32.exe Properties HE I

Generd  Shortout | Securty |

EE Shartout to Postbl32 sxe

Targetbyps:  Application
T atoet location: Manage
Taiget: !“E:EF'rugrarn Filss\iManage'Porthi32.ewe™ FS20

¥ Pone serarate memce) ipece 1 Run as different user

Start irc i"C:\ngram Files\iManage"

Shorteut key: ‘Hq:me

Rur {Momal window ]

Comment ]

Find Tanget... | Change lcan... |

0K Cancel | Apply

Figare 9.9: Shorteut Properties silent mode dialog box to purge echo documents
for all users
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